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About This Handbook: 

This resource was created by  
Writing Center staff as a  
supplement to the MLA Handbook. 
The Intro to MLA provides an  
overview of the most important  
elements of MLA Style, with  
sections on formatting, citations,  
and using Microsoft Word for MLA.  
 
Throughout this resource are links to 
helpful handouts and videos on MLA 
Style and other related topics.

Some tips and notes:

•	 Throughout this booklet, you will see  
references to the MLA Handbook in  
brackets like this [1.1]. You should refer 
back to the MLA Handbook for additional 
information as needed. 

•	 This handbook is not formatted in MLA 
Style, as MLA Style was designed for  
academic papers, not instructional manuals. 

•	 The booklet is not intended to replace  
the MLA Handbook but rather will help you 
interpret the manual and call your attention 
to some of its most important features. You 
should always refer back to the MLA Hand-
book as needed for more detailed  
information. 

•	 While we will provide you with MLA Style 
guidelines and rules here, instructors may 
have own approach to MLA Style, and you 
should always follow assignment  
instructions first. When in doubt, ask  
your instructor for their preference.

Other Writing Center Services:

The Writing Center, Winona  
offers in-person, email, and virtual  
consultations as well as webinars 
and workshops on a variety of  
topics. Students can also access 
writing, citation style, and other  
resources on our website. Please  
go to write.smumn.edu for more  
information.  

http://write.smumn.edu
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Part One: Formatting

Margins [1.1] and Indents 
Set margins at 1 inch on all sides unless instructed otherwise. (Check the default setting 
which may not be 1 inch.) Your last name and page number should be 0.5 inches from the 
top of the page. 

Indent the first sentence of each paragraph 0.5 inches (one Tab space).  Indent long quotes 
(four or more lines) 0.5 inches on the left side only. Do not indent the first line of the quote 
unless the original is the beginning of a paragraph. For example:

music on cell phones, and checking in with parents on Facebook. Bucksch et al. discussed the  

normalization of screen-time behaviors: 

	Clearly, screen time behaviors (STBs) form an important part of young people’s leisure 

time. With continuous technological advances, the choice of innovative and attractive 

devices supports high levels of screen time.... The availability of screens, ready access to 

the Internet, and the increasing importance of social media in young people’s lives has 

normalized STBs across the world. (p. 422)

This long 
quotation is 
indented 0.5 
inches.

Note that the period goes before the 
citation in long quotations. 

Font [1.2]
We recommend using Times New Roman size 12.  Do not use underlining or all capitals unless 
your instructor specifies these. Keep the font the same throughout the paper.         

Line Spacing [2.21]
Double-space all lines in the paper, including Works Cited page entries unless your  
instructor specifies otherwise.  The first line of each page begins at the top margin.  Use the 
double-space setting; do not double-space manually by pressing the Enter key twice  
between lines.

Alignment 
Alignment is set at the left margin for all text except for titles and your running head.  Text 
should align evenly on the left margin but be ragged on the right margin, like the text on 
this page. 

Grammar Help
Check out these resources for additional help

Commas

Semicolons and Colons
Parallel Structure

Clauses and Phrases

https://write.smumn.edu/wp-content/uploads/2020/08/Commas.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Semicolons-and-Colons.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Parallel-Structure.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Clauses-and-Phrases.pdf
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Title, Running Head, and Page Numbers [1.3, 1.4]
You should include a header, page number, and title for your essay: 

									             Donaldson 1

Sam Donaldson

Professor Eileen Smith

ENG 101

3 April 2021

The Truth Hurts: A Rhetorical Analysis

While most people wouldn’t consider an action movie to tbe the epitome of culture, but

Your first and last name Your running head should 
be your last name. 

Your course number

The date of submission. Note the format of the date: Day Month Year. 

Your professor’s name

Start the page number on the first page.  

Your title should be centered 
and follow standard title 
conventions. See p. X

Your header should  
include the four 
elements here. 

Headings [1.5]
Headings may be appropriate for long papers. You must have at least two of each level of 
heading. Headings should be aligned left (not centered). Here is the format we recommend: 

Title of the Paper

Level 1 Heading

Use Level 1 headings to divide your paper into the major sections. 

Note that paragraphs are indented. 

Level 2 Heading

The Level 1 heading is aligned left and bold. 

Level 2 Heading

Use Level 2 headings to subdivide Level 1 headings. The Level 2 

heading is aligned left. 

Level 3 Heading

Use Level 3 headings to subdivide Level 2 headings.

Level 3 Heading

The Level 3 heading is aligned left and italicized. 

You can’t  
subdivide a  
section by one. 
Note that there 
are two Level 1 
headings here. 
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Part Two: Crediting Sources

Where and Why We Credit Sources
Sources are credited both within your essay in in-text citations and at the end of your  
essay on the Works Cited page. You need to credit sources for several reasons: 

Academic Ethics: Honesty and fairness require you to let your readers know whose 
words or ideas you have borrowed and/or analyzed. Even when you put a direct quote 
in your own words by paraphrasing, you are still obligated to identify the source. 

Scholarly Credibility: All research is founded on or related to previous scholarly work. 
Therefore, you need to relate your ideas to what has been written before. Crediting 
this previous work establishes your credibility and provides context for your ideas.  

Source Retrieval: For various reasons, readers may want to view the sources you used 
in a piece of writing.  You are responsible for providing sufficient documentation in a 
systematic way (e.g., in MLA Style) so that readers can retrieve the information being 
used. 

How to Begin
Compose your Works Cited page as you do your research for the following reasons:

1.	 Creating the MLA Style Works Cited entry helps you understand your source—who 
wrote it, when it was published, and who published it.

2.	 When you compose your Works Cited entry, you will recognize if a crucial piece of 
source information is missing.  You can then decide whether to locate the missing 
information or avoid using the source.

3.	 You will know how to cite the source in the body of your paper.  The first 
element of the Works Cited entry (author name) tells you how to write the brief  
citation in your paper.  

Sometimes you might use an indirect or second-
hand source. If you use an indirect source,  you 
would not include an entry on your Works Cited 
page for it, but you would cite it within your essay 
like this: 

Patterson agreed with this assertion about the  
author (qtd. in Smith 421). 

How do I cite an 

indirect source? 
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Works Cited Page
 

Works Cited Page Format
Your Works Cited page should have the same margins and font as the rest of your paper. Here 
are some other formatting tips:

Do Don’t
•	 Start your Works Cited page on a new 

page following the last page of your  
essay. 

•	 Double-space your entries. 
•	 Alphabetize your entries (see p. 30). 
•	 Use a hanging indent (see p. 29). 

•	 Include extra spaces between entries. 
•	 Use bullets or numbers for your entries. 
•	 Copy and paste from a database without 

checking for correctness (see p. 38). 

Click here to see how to cut and paste entries from a database like SuperSearch.

Works Cited Entry Basic Format

MLA Style is easier to learn when you recognize patterns of rules. Instead of trying to  
remember dozens of individual examples, learn the nine basic elements that comprise all  
entries. Note the required punctuation between elements in red. 

1 Author. 2 Title of Source. 3 Title of Container, 4 Contributors,

5 Version, 6 Number, 7 Publisher, 8 Date, 9 Location.

1   Author. [5.3-5.22]

The first author’s name should be reverse order—lastname, firstname—since the last name is 
how your reader will locate the source from your in-text citation. If there are two authors, 
the second author’s name is in “normal” order—firstname lastname. You can see some  
samples below. 

American Cancer Society. 

Wilde, Oscar. 

Pratchett, Terry, and Neil Gaiman. 

West, Samantha, et al.

Organization

Individual

Two authors

Three authors (see p. X to see more about “et al.”)

Note that you do not reverse organization names. 
You should, however, omit articles at the beginning 
of organization names.  

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Paste%20-%20Storyline%20output/story.html
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1   Author. [5.3-5.22], continued

In the rare case in which the author of a source is not identified, move the work’s title into 
the author position and alphabetize by the first word of the title in place of the author’s 
name. Click here to see an example. 

2   Title of Source. [5.23-5.30]

Titles should be as in the published text except that capitalization should be standardized as 
needed. 

Title as Published:

“Black Lives Matter and the Revitalization of Collective Visionary Leadership.”

Title on Works Cited Page:

Quotation marks were added 
because this is an article title.

The capitalization was standardized to be title case (all 
words were capitalized except articles, conjunctions, 
and short prepositions. 

Here are some other title examples: 

“Pathos & Ethos: Emotions and Willingness to Pay for Tobacco Products.”

Wuthering Heights.

“Aristotle and Education.”  

Book title

Article published in the journal PLoS ONE

A page on a website
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3   Title of Container, [5.31-5.37]

Many types of sources have “containers.” This means they are smaller works published  
within larger works. Not all sources have a container, but if your source appears within  
another text (a collection, website, journal, etc.), then it will have a container title. 

Some sources will even have two containers. For students, this is mainly journal articles that 
are located on a library database. The chart below identifies common sources and their  
containers: 

“Title of Webpage.”

Source

Title of Book.

“Short Story.”

“Title of Poem.”

“Title of Article.”

Container 1

Title of Collection,

Title of Book,

Title of Book,

Title of Journal,

Title of Website,

“Title of Chapter.”

Database Name.

Container 2

Sometimes a website may just be the place you accessed the source. For example, if you 
purchase an e-book from an online website, the website is not a container because it did not 
publish the text. Here are some sample containers: 

Alcoholics Anonymous, 

Journal of Further & Higher Education, 

The Norton Anthology of Poetry,  

A website title

A journal title

An anthology title

4   Contributors, [5.38-5.47]

Some sources have additional contributors—directors, editors, actors, translators, etc.—that 
you should recognize in your entries. Here are some examples: 

translated by Helen R. Lane, 

edited by Harold Bloom,  

directed by Quentin Tarantino,

A translator

An editor

A director
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5   Version, [5.48-5.50]

Some sources will have a version identified. This most commonly will be an edition number 
for a book. Here are some samples: 

3rd ed., 

Updated ed.,  

unabridged version,

Note the period after “ed.”

   
6   Number, [5.5-5.53]

A source may also have a “number,” which is usually a volume and/or issue number. 

Vol. 12, no. 3, 

no. 9, 

Capitalize the number element when what precedes it is a period. 

Do not capitalize the number element when what precedes it is a comma. 

      
7   Publisher, [5.54-5.67]

The publisher is the company or entity that produces the source. Here are some examples: 

Penguin Press,  

Mayo Clinic, 

A book publishing company

An organization that publishes a website

8   Date, [5.68-5.83]

For most sources, you will give the year of publication. For sources that have an exact date 
of publication, format it like this: 11 May 2021. Note that all months except May are  
abbreviated to three letters (e.g., Oct., Nov., Dec.). 
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9   Location. [5.84-5.99]

A source’s location might be its page numbers within its container, the URL where it was  
published, or a DOI number.

pp. 34-41.  

https://www.theguardian.com/cities/2020/oct/15/study-reveals-worlds-most-walkable-cities.

https://doi.org.10.1177/0907568215570072.

Page numbers

A URLA DOI

 

Optional Elements. 

The MLA Handbook recommends providing additional elements in your Works Cited page  
entries to help your reader locate and/or understand your source. While there are many, 
here are the most common optional elements students might use: 

Lecture.  

Accessed 5 May 2021. 

Transcript.

Include a word/phrase like this if you heard the information.

Include the date of access for webpages.

Use “transcript” if you read a speech instead of listened to it. 
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Works Cited Page Examples: Print Sources

Book

Kamenetz, Anya. The Art of Screen Time: How Your Family Can Balance Digital Media and 

Real Life. PublicAffairs, 2018. Book titles should be in italics. 

Chapter in an Edited Book

 Cuijpers, Pim, et al. “Technology-Assisted Treatments for Mental Health Problems in Children 

and Adolescents.” Evidence-Based Psychotherapies for Children and Adolescents, edited 

by John R. Weisz et al., 3rd ed., Guilford Press, 2017.

Place the authors of the chapter at the beginning. 

Do not invert the editors’ names. 

Periodical Article: Journal

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 to 

2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. 

Use the first name and “et al.” when a source has three or more authors. 

Journal titles should be in italics. 

Works Cited Page Examples: Digital Sources

Webpage or Document From a Website

 Summers, Juana. “Kids and Screen Time: What Does the Research Say?” NPR, 28 Aug. 2014.      

www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-re-

search-say. Accessed 21 April 2021.

This page was found on the NPR website, so we need to note 
the title of the container (in italics). 

Give the date of access if there is no publication date or if you 
think the webpage/site may be taken down or changed.

http://www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-research-say
http://www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-research-say
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Works Cited Page Examples: Digital Sources, continued

Webpage With No Named Author 

 Artificial Sweeteners and Other Sugar Substitutes: Bewildered by the Variety of Sugar Substi-

tutes Available These Days? Mayo Clinic, 20 August 2015, http://www.mayoclinic.org/	

healthy-lifestyle/nutrition-andhealthy-eating/in-depth/artificial-sweeteners/art-20046936 

If the webpage is written and published by a non-government entity, move the title into the author position and 
give the organization name as the publisher only [5.19].

 
Journal Article from a Database

Craig, Shelley, et al. “Connecting Without Fear: Clinical Implications of the Consumption of 

Information and Communication Technologies by Sexual Minority Youth and Young 

Adults.” Clinical Social Work Journal, vol. 43, no. 2, 2014, pp. 159-168. https://doi. 

org/10.1007/s10615-014-0505-2. Format the DOI number like a URL (https://doi.org/....).

DOI numbers [5.93]
DOI is an abbreviation for Digital Object Identifier, a unique set of characters assigned to 
identify a source so that it is searchable on the Internet.  Most, but not all, databases now 
assign DOI numbers to sources. In some databases, the DOI appears in the short citation; in 
others, you must click on the source title to obtain the DOI. Within your Works Cited page 
entries, the DOI should be formatted as a hyperlink (https://doi.org./10....).

The instructions below explain how to use a DOI to find a source on the Internet. If the DOI is 
long, you can use http://shortdoi.org to shorten it. 

1.	 Go to your web browser and type the 
following on the address line: dx.doi.org. 

2.	 When the DOI page opens, type or copy 
the DOI and then click Go.  

https://www.mayoclinic.org/healthy-lifestyle/nutrition-and-healthy-eating/in-depth/art-20046936
https://www.mayoclinic.org/healthy-lifestyle/nutrition-and-healthy-eating/in-depth/art-20046936
https://doi. org/10.1007/s10615-014-0505-2
https://doi. org/10.1007/s10615-014-0505-2
http://shortdoi.org/
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Works Cited Page Examples: Digital Sources, continued

Course Materials (PowerPoint slides, lecture notes, handouts, etc.) 

“Week 5 Introduction.”  Advanced Research, Writing and Communication, taught by Michelle 

Herrin. Canvas, Saint Mary’s University of Minnesota, 21 April 20201, https://smumn.

instructure.com/courses/4137/discussion_topics/46369?module_item_id=247590

The title of the course should be in italics since it’s a container.
The title of the item should be in 
quotation marks. 

TED Talk, YouTube, or Other Streaming Video

Park, Youngna. “How We Make Screen Time for Kids Beautiful and Meaningful.” YouTube, 

uploaded by TEDxNewYork, 1 Dec. 2016, http://www.youtube.com/watch?v.=0M-

2mc7xB_fw. Accessed 13 May 2021.

 
Works Cited Page Examples: Other Sources

Film

The Squid and the Whale. Directed by Noah Baumbach, Samuel Goldwyn Films, 2005. 

You might include other contributers, too. For example, if you are specifically 
writing about the acting, you might include a specific actor’s name. 

Supreme Court Decisions

United States, Supreme Court. Sanders v. United States. 1 June 2021. Legal Information Insti-

tute, Cornell Law School, https://www.law.cornell.edu/supremecourt/text/20-6400.

https://www.law.cornell.edu/supremecourt/text/20-6400
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In-text Citations

Purpose of Citing in Your Paper
A citation is a “note” within your paper that lets your reader know where the information 
came from. You must include an in-text citation for all exact quotations and paraphrases 
taken from sources and also cite all information that isn’t common knowledge. 

“Common knowledge” doesn’t have a universal definition, so we suggest erring on the side 
of finding (and citing) support for all claims, controversial stands, specific facts, etc. The  
table below gives you some guidelines on what may and may not be “common knowledge,” 
but you will need to use your best judgement and/or ask for clarification from your  
instructor or Writing Center staff as needed.  

All citizens are guaranteed public 
education from kindergarten to 
twelfth grade.

The IDEA guarantees special  
education services to those  
students who need them.  

Leading is different than  
managing. 

Good leaders build strong  
interpersonal relationships with 
their employees. 

Meditation is a well-known  
mindfulness strategy. 

Meditation has been shown to 
reduce blood pressure. 

It is imperative to maintain stable 
hemodynamics during surgical 
procedures.

One in three Americans has high 
blood pressure. 

There are many different kinds of 
learning strategies. 

Active learning has been shown to 
impact knowledge retention more 
than other learning strategies. 

Probably Common Knowledge Probably Not Common Knowledge

Most people wouldn’t know 
what this specific law is. 

These are claims that  
someone might disagree 
with.  

This is a claim that someone 
might disagree with.  

This is a specific statistic.

Don’t press Tab or  
Enter to center your 
text. There are two 
ways to align your  
text (see p. 23, too), but this is the quickest. First, 
highlight the text you want to center. Then click 
the Center button as shown above. 

How do I center 

my title or  
headings?

Left

Center
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In-text Citation Basics
In MLA Style, the first item in the in-text citation should be the author of the source because 
this enables the reader to easily locate the source’s entry on your Works Cited page. You can 
see this connection below: 

Paragraph from the essay: 

Because of the increasing use of  

technology, the evidence is clear that STBs 

are increasing worldwide. Over 65% of  

adolescents exceed the recommended 

amount of screen time per day (Straatmann 

et al. 240).  Similarly, Bucksch et al. found the 

STBs for adolescents increased two hours 

per day from 2002 to 2010 even while some 

experts recommend less than two hours of 

total screen-time per day. While it’s clear that 

STBs are increasing, it’s less clear if these 

behaviors are overall negative or positive. 

Herrin 11

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 

2002 to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-

425. https://doi.org/10.1016/j.jadohealth.2015.11.014. 

Straatmann, Viviane S., et al. “Changes in Physical Activity and Screen Time Related 

to Psychological Well-Being in Early Adolescence: Findings from Longitu-

dinal Study ELANA.” BMC Public Health, vol. 16, no. 1, Sept. 2016, pp. 

1–11. https://doi:10.1186/s12889-016-3606-8.

1

1 2

2

A reader would look at the Straatmann et al. citation (     ) and know that in order to learn 
more about this source, they could look on the Works Cited page under Straatmann. 

If there is no named author, you would use the first element that appears in the Works Cited 
page entry (see example here), which would be either an organizational author (e.g., World 
Health Organization) or a title. You should put the title into either italics (books) or quota-
tion marks (articles or webpages) as appropriate. 

2

https://doi.org/10.1016/j.jadohealth.2015.11.014.
https://doi:10.1186/s12889-016-3606-8
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Where and When to Cite? 
Two frequent MLA questions are: How often should I cite and where should I cite? The  
answers depend on how you are using the sources. You can cite using running text or  
parenthetical citations:

According to Bradford, Alcott’s family got “all her affection, all her personal devotion” (393). Alcott 

spent most of her childhood in Concord, Massachusetts where her family was poor but content 

(“Louisa May Alcott”). 

To cite in running text means to place the author’s name in the 
sentence without parentheses (always place the page number in 
parentheses at the end of the sentence). 

To cite parenthetically means to place the author’s name (or the title in this case because there 
was no named author) in parentheses at the end of the sentence (along with the page number if 
there is one). 

Citing Works by Multiple Authors (using “et al.”)

The table below explains how to cite sources with three or more authors in running text and 
parenthetical citations using the phrase “et al.” which means “and others.”

One or Two  
Authors

Three or More 
Authors

... (Matsuda and Silva 34) .

Parenthetical Citation

... (Bucksch et al. 243). Bucksch et al. write...

Running Text Citation

Matsuda and Silva say...

Note that there is a period after “al.”

Essay Help
Check out these essay resources for additional help

Paragraph Organization
Essays 101
Reverse Outlining

https://write.smumn.edu/wp-content/uploads/2020/08/Paragraph-Organization.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Essays-101.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Reverse-Outlining.pdf
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Quoting and Paraphrasing

Quoting
Use direct quotes sparingly. Quoting does not indicate how well, or even if, you understand 
the material you are quoting.  Overuse of quotes, therefore, can cause you to lose credibility 
with your readers.  Quoting can also disrupt the flow of your writing; suddenly encountering 
another person’s writing style can be jarring to readers.

If you do quote, have a good reason to do so. For example: 
• to discuss the way an author expressed his or her ideas,
• to present a controversial or disputed statement verbatim,
• to convey precise technical data or directions,
• to produce a rhetorical effect when introducing or emphasizing a point.

Quoted text of fewer than about four lines must be enclosed in quotation marks and fol-
lowed by the page number of the original text:

Cheak-Zamora and Thullen write that "education and training for providers is essential to ensure 

they understand the needs of people with DD and/or multiple conditions and are working to ad-

dress quality and access issues" (43).

Quoted text of four or more lines should be formatted as a block quotation. 

Paterson and Chicola describe their informal mentorship as follows: 

We co-negotiated difficult solutions to problems with our pesky “human” resources; we 

explored structural and governance strategies; and we diffused the challenges in our  

personal lives by talking with an empathetic female ally who was at the same time a  

professional colleague and friend. (36) 

Quotations within a block quotation should be surrounded by 
double quotation marks. 

Also note that the end punctuation occurs 
before the parenthetical citation in block 
quotations. 

Omit the 
quotation 
marks around 
a block  
quotation. 
See p. 3 for 
more  
information. 
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Quoting, continued

Integrating Quotations
If the quote is a complete sentence, capitalize the first word. 

According to Li, “Information technology is an important part in Flipped Classroom, which decisively influences 

the depth of the students’ extracurricular learning and the creation of students’ learning environment” (1962). 

Harris said, “Finding information is an art, not a science” (214).

However, if the quoted text is not a complete sentence or if a quoted sentence follows the 
word “that,” do not capitalize the first word or precede it with a comma.  

Quincy acknowledged that “negotiations over bride price sometimes involved more than the price of the bride” 

(105).

Do not capitalize the first word of a quoted phrase (i.e., an incomplete sentence).

Bryson called the English language “a merry confusion of quirks and irregularities that often seem willfully at odds 

with logic and common sense” (1).  

You should not use an ellipsis before or after a phrase taken from a complete sentence. 

Sutter was fascinated with Lake Superior's ore boats and foreign freighters because they “seemed impossibly  

exotic” (2). 
This is a phrase taken from a complete sentence in the source, but it 
doesn’t need ellipses around it. 

You should use an ellipsis to indicate missing words/sentences from the middle of a  
quotation; however, this would be rare since you shouldn’t be using long quotations in  
general. 



17

When to Cite
You should always ensure clarity when citing. This means that it must be 100% clear to your 
reader what information is from a source (and which source).

When you are using only one source within a paragraph, you can sometimes only cite once, 
but remember that your reader cannot know your intent, so it must be completely clear 
from your writing/citing alone what is and isn't taken from a source. Here is a sample: 

         It can be difficult to reconcile these two sides of the issue. As Smyth says, 

there is something safe and comforting about “gentle, youthful rebellion and [a]

poor but loving family” (13). On the other hand, there is a lot of evidence that 

Little Women is decidely anti-feminist. After all, the choices seem to be to get 

married or “die beautifully” (9).

It’s not clear is this 
sentence is a paraphrase 
from Smyth or an original 
idea by the writer of the 
paper. 

         It can be difficult to reconcile these two sides of the issue. As Smyth says, 

there is something safe and comforting about “gentle, youthful rebellion and [a]

poor but loving family” (13). On the other hand, there is a lot of evidence that 

Little Women is decidely anti-feminist. After all, the choices seem to be to get 

married or “die beautifully” (Smyth 9).

Incorrect:

Correct:

By citing the last sentence with author and page number, it’s 
clear that the sentence before it is not from a source. 

Since you can’t know if your reader will be confused and because it’s not incorrect to cite 
every sentence, this is what we recommend in the Writing Center. 
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Paraphrasing

How to Paraphrase
You have probably heard that paraphrasing involves putting a source in “your own words.” 
Adequate paraphrasing, however, involves more than just replacing words in the original 
with synonyms, or words that are similar in meaning to the original. Successful paraphrasing 
requires you to change not only the words but also the structure of the original passage. We 
recommend reading the passage and then putting the source away to avoid poor paraphras-
ing techniques (i.e., just changing every word to a synonym). 

There are several strategies that you can use to paraphrase your sources. You will need to 
use more than one strategy in order to avoid plagiarism. Here are six strategies: 

#1 Change word form or part of speech 
#2 Change from active to passive voice, or vice versa 
#3 Change the word order 	
#4 Change from specific to general 
#5 Change transitions 
#6 Replace words in the original with synonyms

The process might take several drafts. You can see an example below: 

Original 
Quotation

This can be 
changed from active 
voice to passive 
voice (#2). 

This can be 
changed to a 
synonym (#6).

This can be 
moved to the 
beginning to 
change the 
structure (#3).

From 2002-2010, it was observed that there was a rise in computer use 
(Bucksch et al. 420).

Strategies

Draft 1

Strategies

Draft 2

This could also 
be changed to a 
synonym (#6). 

In the 2000s, a rise in computer use was observed (Bucksch et al. 420).

“We observed a strong increase in computer use, including nongaming and 

gaming activities, from 2002 to 2010” (Bucksch et al. 420).

This could be moved to the end (#3). 
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Part Three: Using Microsoft Word for MLA
Getting Started & General Tips

A Word on MLA Format and Instructor Requirements
This section will provide you with instructions on how to format your documents according to 
the requirements and guidelines of MLA Style. 

However, every instructor and assignment is different. You should always refer to your  
assignment sheet and the instructions given to you by your instructor in terms of formatting. 

Before We Start

To get the most out of the instructions that follow, please familiarize yourself with the  
following topics.

Ribbon Bar: The Ribbon Bar is how you will navigate through all of the options in Word. 
The diagram below will familiarize you with the elements of the Ribbon Bar.

Each tab is divided into sections. For example, 
the Home tab is divided into Font, Paragraph, 
Styles, and Editing. 

The Quick Access Toolbar contains  
frequently used tools, including Save and 
Undo. You can add/remove items to this 
toolbar by clicking on the arrow. 

The Ruler lets you adjust the indentation of 
your text. To see the ruler, you might need 
to go to the View tab and check the box next 
to Ruler.

The Ribbon Bar is divided into tabs: Home, Insert, Layout,  
References, Mailings, Review, View, and Help.
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Ruler: This tool allows you to indent directly from the main screen. 

Use the upper triangle to indent the first line of a 
paragraph. 

Use the lower triangle to indent subsequent lines 
of a paragraph. Use the square to indent a block of text.

Show/Hide: This function allows you to see hidden formatting codes,  
which is helpful when you need to correct or modify formatting. 

Find this button within the Paragraph section of the 
Home tab. When you press this button, you’ll see all of 
the formatting codes within your essay. 

indicates you pressed Enter. 

Common codes include:

indicates that you pressed the space bar. 

indicates you pressed Tab. 

indicates you inserted a page break. 

¶

Page Break

            The daily use of technology has

among adolescents. There is an increas

today, beyond just television watching

This can be helpful when you have a format-
ting error in your essay. For example, here 
it shows that the space bar was pressed to 
indent this paragraph instead of using the Tab 
key, which can result in uneven spacing. 

Undo:

The Undo button is located in the 
Quick Access Toolbar and allows you to 
cancel your last command(s). 
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Initial Setup of MLA Papers

Set up MLA format before you begin typing. You can set formatting for one paper, or you can 
change the default so that the formatting stays set for all future papers (you can always 
change this at any time), which is what the directions below will explain how to do. 

Font: We recommend using Times New Roman 12-point font in all of your papers. Your font 
should always be black. 

12

In the Font section of the Home tab, click on the 
arrow in the bottom, right-hand corner. 

In the Font menu, choose:
	 Font: Times New Roman
	 Font style: Regular
	 Size: 12

To save these settings for this paper only, click on OK.  

To save these settings for all future 
papers, click on Set As Default. 
Select “All documents based on the 
Normal template” and then click OK.

1

2

4 3

1

2

3

5

4

5

11
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Margins: Your margins should be set to 1 inch throughout your essay. 

To save these settings for all future papers, click on Set 
As Default.
Then click Yes.

4 3

Under the Margins tab of the Page Setup 
menu, make sure all four margins are set at 
1 inch. 

2

To save these settings for this paper only, 
click on OK.  3

5

4

2 1

In the Page Setup section of the Layout tab, click on the 
arrow in the bottom, right-hand corner. 1

5
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Line Spacing, Indents, Text Alignment: You should change these settings  
before you start typing. Your writing should be aligned left (except for centered  
headings and titles) and your entire document should be double-spaced. 

Set Alignment to Left. 

Set Indentation to 0” 
both left and right. 

Set Line Spacing to 
double. Set Before to 0 
and After to 0. 

2

4

3

2

3

To save these  
settings for this paper 
only, click OK. 

5

4

5

To save these settings for future                         
papers, click on Set As Default, choose 
the appropriate option, and click Yes.

6

6

In the Paragraph section of the Layout 
tab, click on the arrow in the bottom, 
right-hand corner. 

1

1
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Page Numbers and Page Headers: The instructions here will help you
insert your page numbers and header.   

1
From the Insert tab, click on the arrow 
next to Page Number in the Header & 
Footer section. 

1

Click on Top of Page and then Plain 
Number 3. This will insert the page 
number on all pages within your  
document.  

2

2

Within your header (you can always double click to access it), put your cursor in front of the 
page number, and type your last name. Select all elements within the header and change 
the font (if needed) to the same font at the body of your paper. Then double-click below the 
dotted line to exit your header.

3
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Page Breaks: You will need to manually insert page breaks at certain points in your essay 
before your Works Cited page, for example. You shouldn’t press Enter multiple times to do 
this because you will create formatting issues. Instead, follow the steps here. 

Further research should be done to understand any socioeconomic and/or sociocultural rea-

sons for the increased STBs in adolescents. 

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 

to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014. 

From the Insert tab, click on Page Break. You 
can also press CTRL+Enter when typing. 

Place the cursor at the start of the paragraph 
you would like to be on a new page. Here, the 
cursor is right before “Works Cited.”

Essentially, if you cite correctly and often enough 
(see pp. 12-18 and other resources on our website 
at write.smumn.edu), then you should be able to 
avoid unintentional plagiarism. However, here are 
some tips to help you avoid some common  
challenges: 

1.	 Give yourself enough time. It’s easier to make careless errors if 
you’re rushed. 

2.	 Read the material carefully. Students sometimes plagiarize  
because they don’t fully understand the texts.

3.	 Take notes. If you are paraphrasing from your own notes, then 
you are relying on your own interpretation (include correct  
citations though). 

4.	 Visit the Writing Center. We can help you note issues with  
citations before you submit your paper. 

How do I avoid 

plagiarism?

http://www.write.smumn.edu
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Formatting Within the Paper

This section will help you format various parts of your essay, including block/indented  
quotations and headings. 

Block/Indented Quotations: While you should use exact quotations  
sparingly, if you use a quotation of about 4 lines or more, you will need to  
format it as a block or indented quotation as shown below. 

Paterson and Chicola describe their informal mentorship as follows: 

We co-negotiated difficult solutions to problems with our pesky “human” resources; we explored structural and gover-

nance strategies; and we diffused the challenges in our personal lives by talking with an empathetic female ally who was 

at the same time a professional colleague and friend. (36)

Highlight the quotation. 2

3

To format a block quotation, first type the quotation. It should be double-spaced like the rest of your paper. 1

Paterson and Chicola describe their informal mentorship as follows: 

          We co-negotiated difficult solutions to problems with our pesky “human” resources; we explored structural and    

           governance strategies; and we diffused the challenges in our personal lives by talking with an empathetic female  

           ally who was at the same time a professional colleague and friend. (36)

 Click on the Increase Indent icon in the Paragraph section of the Home tab. 3

Google Docs is a great tool for collaborative  
writing. For example, if you’re writing a paper with 
some classmates or if your instructor wants to 
comment on your paper during the drafting stage. 
However, a Google Docs document does not format 
in the same way as a Microsoft Word document, so 
it is best to transfer your text to a Microsoft Word 
document for formatting purposes. 

Can I use 
Google 
Docs?
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Word Count: You can always see your word count at the bottom, left-hand corner of your 
screen. 

You can also see your word count and 
additional information if you click on 
Word Count in the Proofing section of 
the Review tab. 

You can see the total number of words in your document at the bottom of the 
screen. To see the number of words in a section, highlight the text. You’ll then 
see a ratio of highlighted words to total words. 

Sometimes you’ll need to use a symbol either  
within your own text or within Works Cited page 
entries, like the section symbol (§), 
which is used when citing statutes. 
To find symbols, click on the Insert
tab in Word and then click on the 
little arrow next to Symbol within 
the Symbols section. 

How do I  
type §  
and other 
symbols? 

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Insert%20Symbols%20-%20Storyline%20output/story.html
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Word Help
Check out these videos for additional help

How to: Alphabetize
How to: Create a Hanging Indent
How to: Format Block Quotes
How to: Format Margins
How to: Set Line Spacing
How to: Paste
How to: Set Paragraph Alignment
How to: Format Table of Contents
How to: Insert Page Numbers

Bulleted or Numbered Lists

Click on the Increase Indent icon to indent the list 0.5 inches.Type the list and then highlight it.

There are a variety of health concerns related to both STBs and the resulting sedentary 

behaviors of teens: 

•	 Higher STBs predicted obesity in teens, especially for teens who have a TV 

in their bedrooms (Wethington et al. 24). 

•	 Cholesterol levels and high blood pressure were more likely in teens who had 

excessive STBs (Tremblay et al. 143).

•	 Lower self-worth and self-esteem levels were found in teens with higher 

levels of STBS (Tremblay et al. 143).

Click on the Bullet icon                  or the Number icon                 in the Paragraph section of the Home tab.  

3

2 3

1

Use numbers when the  
order of the items is  
important, for example, 
when you are listing the 
steps in a process. 

Use bullets when the order 
isn’t important. 

1

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Alphabetize%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Create%20a%20Hanging%20Indent%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Block%20Quotes%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Margins%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Set%20Line%20Spacing%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Paste%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Set%20Paragraph%20Alignment%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Table%20of%20Contents%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Insert%20Page%20Numbers%20-%20Storyline%20output/story.html
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Works Cited Page
This section will address the formatting of your Works Cited page, including hanging indents 
and alphabetizing. 

Hanging Indent: Do not create hanging indents manually—doing so will  
cause formatting issues if you revise anything on this page. 

Herrin 13

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 

to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014. 

Craig, Shelley, et al. “Connecting Without Fear: Clinical Implications of the Consumption of 

Information and Communication Technologies by Sexual Minority Youth and Young

In a hanging indent, the first line of each citation is aligned left, and all 
subsequent lines are indented.

1
Click on the arrow in the 
bottom, right-hand corner of 
the Paragraph Section of the 
Home tab. 

1

2

3

In the Paragraph 
menu, under Special, 
select Hanging, and 
change the spacing to 
0.5 inches.

2

Click OK.3
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Alphabetize Your Works Cited Page Entries: Once your Works Cited  
page is complete, you can alphabetize your entries easily using the  
Sort icon.

Herrin 13

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 

to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014. 

Craig, Shelley, et al. “Connecting Without Fear: Clinical Implications of the Consumption of 

Information and Communication Technologies by Sexual Minority Youth and Young

Highlight your entries (be 
sure to exclude the title of 
Works Cited).

1

2

4

3

Click on the Sort icon in the Paragraph 
section of the Home tab.

Under Sort by, be sure that Paragraphs 
and Ascending are selected. 

Click OK. 

2

3

4
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Matching Reference Entries to In-text Citations: You can use the Find tool in Word 
to check for consistency between your in-text citations and Works Cited page entries. 

Bucksch et al. added  that these 
“screen-time behaviors

Bucksch et al. said that there are many

and checking in with parents on Face-
book, Bucksch et al. discussed causes 
of the

Similarly, Bucksch et al. found the STBs 
for adolescents

trend of decreasing physical activity lead 
Bucksch et al. to demand  
“interventions for

formation, and quality of friendships” 
(Bucksch et al. 421). 

Bucksch

Herrin 13

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 

to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014. 

Craig, Shelley, et al. “Connecting Without Fear: Clinical Implications of the Consumption of 

Information and Communication Technologies by Sexual Minority Youth and Young

This will bring up the Navigation 
pane, which allows you to see 
each time this name is used in 
your paper. 

3

2

4

Highlight the first last name in an 
entry on your Works Cited page. Be 
sure to highlight the name only. 

Click on the Find icon within the 
Editing section of the Home tab.

1

2

You can click on each item or use the arrows 
to scroll through each instance and check for 
correctness. 

4

Bucksch et al. added  that these “screen-time behaviors” have be-

come normalized due to “the availability of screens, ready access 

to the Internet, and the increasing importance of social media in 

young people’s lives” (422).)  Screen time is increasing because 

technologies pervade the everyday life experiences of teenag-

ers: using Ipads at school, listening to music on cell phones, and 

checking in with parents on Facebook. Bucksch et al. said that
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Sample Works Cited Page

Herrin 13

Works Cited

Bucksch, Jens, et al. “International Trends in Adolescent Screen-time Behaviors from 2002 

to 2010.”  Journal of Adolescent Health, vol. 58, no. 4, 2016, pp. 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014. 

Craig, Shelley, et al. “Connecting Without Fear: Clinical Implications of the Consumption of 

Information and Communication Technologies by Sexual Minority Youth and Young 

Adults.” Clinical Social Work Journal, vol. 43, no. 2, 2014, pp. 159-168. https://doi.

org/10.1007/s10615-014-0505-2.

Cuijpers, Pim, et al. “Technology-Assisted Treatments for Mental Health Problems in Children 

and Adolescents.” Evidence-Based Psychotherapies for Children and Adolescents, edited 

by John R. Weisz et al., 3rd ed., Guilford Press, 2017.

 “Family Media Plan.” The AAP Parenting Website, American Academy of Pediatrics, https://

www.healthychildren.org/English/media/Pages/default.aspx. Accessed 21 Apr. 2021. 

Kamenetz, Anya. The Art of Screen Time: How Your Family Can Balance Digital Media and 

Real Life. PublicAffairs, 2018. 

Mastro, Dana, and Michelle Ortiz. “Media and Communication Theories: Implications for a Mul-

ticultural Perspective.” The SAGE Handbook of Child Development, Multiculturalism, and 

Media, edited by Joy K. Asamen, et al., SAGE Publications, 2008, pp. 165-175.

Park, Youngna. “How We Make Screen Time for Kids Beautiful and Meaningful.” YouTube, 

uploaded by TEDxNewYork, 1 Dec. 2016, http://www.youtube.com/watch?v=0M2mc7xB_

fw. Accessed 13 May 2021.

Summers, Juana. “Kids and Screen Time: What Does the Research Say?” NPR, 28 Aug. 2014. 

www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-

research-say. Accessed 21 April 2021.

Twenge, Jean M. iGen: Why Today’s Super-connected Kids are Growing Up Less Rebellious, 

More Tolerant, Less Happy—and Completely Unprepared for Adulthood—and What That 

Means for the Rest of Us. Atria Books, 2017.

https://doi.org/10.1016/j.jadohealth.2015.11.014
https://doi.org/10.1016/j.jadohealth.2015.11.014
ttps://doi.org/10.1007/s10615-014-0505-2
ttps://doi.org/10.1007/s10615-014-0505-2
https://www.healthychildren.org/English/media/Pages/default.aspx.
https://www.healthychildren.org/English/media/Pages/default.aspx.
http://www.youtube.com/watch?v=0M2mc7xB_fw.
http://www.youtube.com/watch?v=0M2mc7xB_fw.
http://www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-research-say
http://www.npr.org/sections/ed/2014/08/28/343735856/kids-and-screentime-what-does-the-research-say
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